CHAPTER 2

Learning the Basics

This chapter introduces you to the new look and feel of Windows NT 4.0 and
provides you with the basic procedures you need to know to begin your work.

Starting and Quitting Windows NT

This section shows you how to log on, start, and quit Windows NT.

Logging on is the process of identifying yourself to the computer by giving your
name and password. This process identifies you as an authorized user and helps
maintain security.

To log on to Windows NT

1. When you start your computer and see the Begin Logon dialog box, press
CTRL+ALT+DEL to log on.

You will now see the Logon Information dialog box.
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2. Type your user name and password in the Logon Information dialog box.

system,

Enter.a user name and passwerd thal is valid forthis

=

Username: -, frichardw

Passwind: ! xxiﬂxxxm\;

Domain; {5aLES

0K ! Cancel ‘ Help ‘ §hutDownmi

=

Your user name was set when your system administrator established your user
account or when you installed Windows NT.

Your password is a security measure to restrict access to your computer by
unauthorized users. A password can contain up to 14 characters and can
include uppercase and lowercase letters. If you do not want to log on with a
password, your system administrator can disable the service.

3. On the Welcome to Windows NT screen, choose one of the following four
options:

What's New? to get answers to common questions asked by users who

have used Windows NT before.

Help Contents to search for Help by typing a subject, title, or specific

word or phrase.

Next Tip to view another tip on the Welcome screen.

Close button to close the Welcome screen and begin working with

Windows NT.

Welcome to Windows

.
@ Did you know. ..

The Shut Down command on the Start menu
enables you to safely shut down yow computer

T Show this Welcome Screan next time: you start Windows NT

‘what's New

HelnContents - |

Next Ty
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To start using Windows NT
® (lick the Start button to display the Start menu.

From this menu, you can start your programs, files, and documents. You also
use the Start menu to quit Windows NT.

To quit Windows NT and shut down your computer
1. Click the Start button and then click Shut Down.

2. Click Shut down the computer.

If you forget to save changes to documents, Windows NT prompts you to save
changes.

A screen message lets you know when you can safely turn off your computer.

Caution Before you turn off or restart your computer, always shut down
Windows NT. That way you can be sure your work is saved to your hard disk.

Getting Online Help

All of the information that you need to learn and use for Windows NT is now
online. You should refer to online Help as your primary source of information to
help you use Windows NT.

Windows NT provides you with two kinds of Help

= Help about specific procedures

= Help about what you see on your screen

When you open Help by using the Start menu or the Help menu in My
Computer or the other icons, you will get Help for Windows NT in general. If
you use the Help menu in a program such as Wordpad, Paint, or Microsoft Word,
the Help you see is specifically for that program.
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To get Help about procedures
1. Click the Start button, and then click Help.
2. The list of Help topics appears.

3. You can use the Contents tab in Help to find topics grouped by subject, or use
the Index tab or Find tab to search for information by typing in a subject, title,
or specific word or phrase.

4. Some Help topics contain green underlined text. You can click the green text
to see a definition of the term.

5. .To return to the list of topics after reading about a specific topic, click Help
Topics.

E you've used Windows before )
@ Introducing Windows NT ' Windows NT Help
23

@ Tips and Tricks

@ Troubleshooting 1 To change the
Q Glossary background of your
desktop

1 Click here M to view
Display properties.

2 Inth s or \Wallpaper
list, e pattern or

wallpaper you want to use.

Tips

To cover your entire screen
with a small wallpaper image,
click Tile. To center a
wallpaper image, click Center.

® ‘YYou can use patterns and
wallpaper simultaneously.
However, if Tile is selected.
you will not see the pattern.
By default, only a limited set of
wallpapers is installed during
Windows Setup. For
information about installing a, .. ..
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To find Help using the Contents tab

Click the Contents tab to find topics grouped
by subject.

To find Help using the index tab

Click the Index tab to find specific topics
listed alphabetically. To scroll through the
Help index, type the first few letters of the
word you want to search for. If you don’t find
the entry you want, type a synonym for the
word you want.

To find Help using the Find tab

Click the Find tab to find all the topics that
contain a specific word or phrase.

Run Programs
@ Work with Files and Folders
@ Pt
@ Use a Network
@ Communicate with Others
@ Safeguard Your Work
() Change Windows Settings
{3 Change How Windows Looks

[3] Changing the way items on the desktop look

[3) Changing how much you can fit on your screen

[B Changing the size of the fonts you computer displays

[3 Setting up a soreen saver
Adjusting the rate st which yaur cursr binks

cleaiing windows

color, changing

filing more information on
icons, addi

Teducing windows to buttons
scraps, addng

shoreuks, adding

sizc of dasktop items, changing
taskbar

tins

wallpaper

determining who is connected to your computer

hanging the background

Baidd e BeR il ol il ditvieh
hanging the font o color of & Help topic
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The What’s This? button, in the upper-right corner of your screen, is an easy way
to get information about an item in a dialog box.

256COLOR
Arcade
Arches
Argyle

To get Help using the What'’s This? button
1. Click the What’s This? button.
The appearance of the pointer changes.

2. Click the item in the dialog box that you want information about. An
explanatory message appears.

3. To make the message disappear, click anywhere on the screen.

Using the New Streamlined Desktop

The new Windows NT screen design makes it easier and faster for you to get your
work done. This section introduces the new screen design and tells you what
happened to the icons from earlier versions of Windows NT.

What’s New on Your Windows NT Screen?

Depending on how your computer is set up, different icons will appear on your
desktop when you start Windows NT. Four icons that are new to Windows NT
are: My Computer, Network Neighborhood, Recycle Bin, and the Start button.

My Computer

My computer displays icons representing various resources available to your
computer. These include floppy disk drives, CD-ROM drives, hard disk drives,
and also any network resources you are connected to such as printers and network
drives. Double-click these icons to see the contents.
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Network Neighborhood

If your computer is set up to use a network directory service, you can double-click
the Network Neighborhood icon to see computers in your workgroup.

Internet Explorer

Double-click the Internet Explorer icon to browse web pages on your local
network and/or on the Internet.

Recycle Bin

The Recycle Bin is a temporary storage place for deleted files. You can use it to
retrieve files deleted in error. These deleted files are not actually removed from
your hard disk until you empty the Recycle Bin.

To delete a file, just drag it to the Recycle Bin.

To empty the Recycle Bin, double-click the icon, click File, and then click Empty
Recycle Bin. To free up disk space, you must empty the Recycle Bin periodically.

Important  If you delete a file at the command prompt or from a disk, it does not
go into the Recycle Bin. It is permanently deleted from your computer.

My Briefcase

If you access files using two different computers, such as a laptop and a main
computer, then you can use My Briefcase to keep your files updated and
synchronized.

Inbox

If your computer is setup to use Windows messaging, you can double-click the
Inbox icon to send and receive messages.

Start Button

The Start button and taskbar are located at the bottom of your screen when you
start Windows NT for the first time. By default, they are always visible when
Windows NT is running. You use the Start button to start programs, open
documents, change system settings, find items on your computer, get Help, and
more.

To see the Start menu, which contains everything you need to begin using
Windows NT, click the Start button. The following list briefly describes each
command on the Start menu.




16 Start Here

This command Does this

Programs Displays a list of programs or program folders you can start.

Documents Displays a list of documents that you’ve opened recently.

Settings Displays a list of system components for which you can change
settings.

Find Enables you to find a folder, file, shared computer, or mail message.

Help Starts Help. You can then use the Help Contents, Index, or Find
tab to find out how to do a task in Windows NT.

Run Starts a program or opens a folder when you type the name or path.

Shut Down Shuts down or restarts your computer, or logs you on as a different
user.

Depending on your computer and the options you have chosen, you might have
additional items on your Start menu.

What Happened to Your Old Windows NT Icons?

Many elements that are familiar to Windows NT users have been replaced by new
icons in this version of Windows NT. Items that have changed include Program
Manager, File Manager, MS-DOS Prompt, Control Panel, Print Manager, the Run
command, task switching, and the Close button.

e

5

Program Manager

You can find your old program groups by
clicking the Start button and then pointing to
Programs. Your groups appear as folders on
the Programs menu.

File Manager

To manage your files, click the Start button,
point to Programs, and then click Windows
NT Explorer. Your directories appear as
folders.

MS-DOS Prompt

To open an MS-DOS window, click the
Start button, point to Programs, and then
click Command Prompt.
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ALT+TAB

Control Panel

To open Control Panel, click the Start
button, point to Settings, and then click
Control Panel.

Print Manager

To set up a printer or look at information
about documents you’re printing, click the
Start button, point to Settings, and then
click Printers.

Run Command

To use the Run command, click the Start
button, and then click Run. You can either
type the name and path of the program that
you want to start or you can just specify the
name of the program. You can execute
MS-DOSe-based and Windows-based
programs, open folders, and connect to
network resources by using Run.

Task Switching

You can use the taskbar to switch between
open windows. Just click the button on the
taskbar that represents the window you want
to switch to. You can also press ALT+TAB to
switch between tasks, just as you did in earlier
versions of Windows NT.

Close Button

To close a window, click the Close button
in the upper-right corner of the window, next
to the Minimize and Maximize buttons.
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Opening, Closing, and Switching Between Programs

There are two ways you can open a program in Windows NT. You can select the
program from your Programs menu. Or, if you know the name and path of the
program you want to start, you can use the Run command to start it.

To open and close a program from the Programs menu

1. To start a program, click the Start button, and then point to Programs. Any
program groups that you have from previous versions of Windows NT have
been converted into folders by Windows NT.

2. Point to the folder containing the program that you would like to open, and
then click the program name.

3. To quit the program, click the Close button in the upper-right corner of the
window.
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To open and close a program using the Run command
1. To start a program, click the Start button, and then click Run.

2. Type the name of the program, folder, or document you want to open. You can
also click Browse to look for the item.

When you use the Run command, you can often specify just the name of the
program instead of the full path.

3. To see items that you typed previously, click the arrow in the Open box.

4. To quit a program, click the Close button in the upper-right corner of the
window.

You can run many programs at the same time, and switch easily between them by
using the taskbar. The taskbar contains a button for each open folder or program
on your computer. You must already have the programs open in order to view
them on the taskbar.
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To switch between programs

¢ Click the taskbar button representing the open program or folder that you want
to switch to.

The program’s window then appears in front of the other windows on your screen.

Matideik
Naightorhbod

Letter to Clara  Letter to Max

Letter to David  Letterto Dr.
Smith

Viewing the Contents of Your Computer

There are two ways you can view programs, documents, and data files that you
have on your computer. You can use the My Computer icon that is displayed on
your desktop, or you can use Windows NT Explorer under Programs on the
Start menu.

To view your computer’s contents using the My Computer icon

1. From your desktop, double-click My Computer. A window appears
displaying additional icons.

2. Double-click these icons to view the contents of your computer.

The following table shows many of the icons likely to appear on your screen,
and explains their uses.
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Double-click this icon

To do this

3 1\2 Floppy A:
5 1M Floppy B:

Disk Drive C:
Audio CD D:

Network Drive E:

Control Panel

Printers

View the contents of a disk in your computer’s
3.5-inch drive, if there is one.

View the contents of a disk in your computer’s
5.25-inch drive, if there is one.

View the contents of your computer’s hard disk.

View the contents of a compact disc in your
computer’s CD-ROM drive, if there is one.

View the contents of a network drive, if your
computer is connected to one.

Change the settings for your computer.

Set up printers and view information about your
printers and the documents you print.

When you double-click a disk-drive icon in My Computer, you see the
following window.

B ty Computer

o H o B

(]

3% Floppy (A} 5% Floppy [B:)

Printers

Metlog.txt

Ntdetect.com
: B] Drvspace.bin é] Ntidr
@ io.dos E}j pagefile.sys
[9 fo.sys {g paint.bmp
] Eﬂj Msdos @] Scandisk.iog
[a_n;] Msdos.bak Lﬂj Setuplog.old
[9_!3 Mzdos.dos @j Setuplog.tst

Audio CD (D)

{5 Shortcut to Excel

Notfinal on
hedinko! (£

Control Panel

@ sms_time. dat
[#] Suhdiog.—
] Suhdiog dat
switch. bmp
B System.Tst
[#] W35undo dat

Edvibacon)

. Double-click any of these icons to start a program, see the contents of a folder,

or view information in a file.
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This icon Represents

1 A folder, which can contain files and other folders. Your directories
appear as folders.

b A shared folder. You set up shared folders so that other people on a
network can use the folder’s contents.

A file, the basic unit of storage in Windows NT. The documents you

use and create are files, and so are the programs you use. Different
files are represented by different icons. If the file type does not have a
specific icon associated with it, then this standard icon will be used to
represent your document.

A document that was created with WordPad, the text editor that is
included with Windows NT.

To view your computer’s contents using Windows NT Explorer
1. Click the Start button, point to Programs, and then click Windows NT
Explorer.

A double-paned window appears. The left side of the window lists all the
names and icons of the disk drives on your computer, as well as files and
folders. The right side of the window displays the contents of any item you
click on the left, along with its icon.

2. Double-click the icon of a document or program that you want to open.
The contents appear in the right window.

% Euplor

9 ) {21 Schdplus ] Bootsect dos 4] pagefite.sys
) ~mssetup.t & scmdmp P command.com  |[#¥ paint.bmp
- {:-j 2”9‘“9 (X Technet Command.dos Scandisk.log
-l Ad A Temp ] Config.bak #) Setuplog.old
{;] Bin [ users Config.dos Setuplog. txt
; {..J Binv 1 Viewer @ Config.sys {5 Shorteut to Excel
mg [E):Ese| Excel [ win32app @ Dbispace.bin Sms.irfi
3 Exchange -} Exchange £a WII:135|J Ell] Detlog.old E] sms_time. dat
-3 Fprot 23 F-prot (A windows %j Detlog.txt ] Suhdlog.--
: help print ! help print gWinnGS {E'J Drvspace.bin E] Suhdlog.dat
mw Letters J Letters @Winraid @Io.dos Eﬁiswilchbmp
“ 27 view Iview '] Autoexec. bak i8] lo.sys {#] System.1st
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5 | EE':C:Ed @Recycled Bootlog txt @ Ntidr
chdplus
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Using Your Mouse to Work Efficiently

This section shows you how you can use your mouse to quickly accomplish
common actions and speed up your work. Notice that your mouse has two
buttons, a left button and a right button. You select an item by clicking it—to
click, quickly press and release the left mouse button (called left-click) or the
right mouse button (called right-click).

Here are some actions that you perform using your mouse:

Move ltems You can move an item by pointing to it, pressing and holding down
the left or right mouse button, and then dragging the item to another location.

Create Shortcuts You can open a file or folder directly from your desktop or from
the Start menu by creating a shortcut icon that represents a link to a document,
folder, disk drive, computer or printer.

Get Help You can get help on any item on your screen by clicking the What’s
This? button and then clicking the item you would like more information on.

Complete Common Tasks You can right-click any item on your screen and a task
menu will appear, listing common tasks that can be performed on that item. Click
a task to activate it.
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Organizing Files and Folders

This section shows you some basic procedures for organizing files and folders on
your computer so that they are easier to work with. The following procedures use
My Computer, but you can also use Windows NT Explorer to do these tasks.

To create a new folder

1. Double-click My Computer, and then double-click the drive or folder in
which you want to place the new folder.

2. On the File menu, point to New, and then click Folder.
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To move or copy a file or folder

1. Double-click My Computer. Find the file or folder you want to move or copy,
and then click it.

8 My Computer a
-

1 3% Floppy (&) 5% Floppy (B:) IC)

(D) Notfinalon  Control Panel
Thedinfol (E:L _

Printers

] ~mssetup.t AExcel {23 Mailing List &f Recycled
A Exchange EMs {22 Schdplus

A F-prot 3 Memail &) scindmp

& . wean - CNT bt

2. Click Edit. To move the file, click Cut. To make a copy of the file, click
Copy.

] !els :

3. Open the folder where you want to place the file, click Edit, and then click
Paste.
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To delete a file or folder

1. Double-click My Computer. Find the file or folder you want to delete, and
then click it.

Letter taMax  Letterto Dr.  SESITHRZARREE

Smith

2. On the File menu, click Delete.

To copy afile to a floppy disk

1. Double-click My Computer. Find the file or folder you want to copy, and
then click it.

2. On the File menu, point to Send To, and then click the drive where you want
to copy the file or folder.

Letter to Clara Letter to David eva bl |
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Using Drag and Drop to Move Information

Sometimes the quickest way to move and copy information is to drag it from one
place to another by using your mouse. You can move or copy files and folders to

another folder or disk drive.

To move or copy by dragging

1. In Explorer, open the folder that contains the file or folder you want to move

or copy.

-{{3 Bin
3 Binr

¢ I Dos
C @) Excel
{2 Fprot K
o Sitel: 9
| Dg 'ie %Leﬂ%o David
1 = £ Ms

L 22 Msmail
o m-{3 Meoffice

Letter ta Dz
Nletter to Max

2. Press down the right mouse button and keep the button pressed down as you
drag the icon to the folder where you want to move or copy it. Then release the
mouse button.

- 459 Exchange
{2 F-prot

i 2] help print
L@l

Letter ta Max
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Installing Software Programs

It’s easy to install software onto your computer using Windows NT. You can add
and remove programs with the Add/Remove Programs utility in Control Panel.

To install programs
1. Click the Start button, point to Settings, and then click Control Panel.

Devices
- AN
=

Keyboard Modems

S8 s s

Card Ports

A @ & & @

Printers gional  SC5| Adapters Server Services

2. Double-click Add/Remove Programs.
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3. The Add/Remove programs Properties dialog box appears. Follow the
instructions on your screen.

Customizing Your Computing Environment

There are many ways in which you can customize Windows NT to suit your
needs. For example, you can change the way your computer screen physically
looks by changing screen colors and backgrounds. You can also change the way
your keyboard and mouse work. And you can create shortcuts to frequently-used
files and programs, which will then open automatically when you start your
computer or click the shortcut icon.

Personalizing Your Desktop

You can personalize your desktop by changing screen colors and backgrounds.
These changes are made using Control Panel.
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To change the way your screen looks
1. Click the Start button, point to Settings, and then click Control Panel.

& Seffings

4% &
sx4

: Accessibilty  Add/Remove Console
Options Programs
g o

Devices
P
Intemet Keyboard Modems

PC Card Ports
Netwark PC

:= %
SCS| Adapters Server Services
System Tape Devices  Telephony uPs

2. Double-click the Display icon.

3. To see more settings, click the tabs at the top of the Display Properties dialog
box.

Display Propertins |
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Opening Frequently-Used Programs and Documents Quickly

If there are programs and documents that you use frequently, you can create a
shortcut to open the program or document quickly. Once created, the shortcut
appears as an icon. The shortcut icon has a small arrow in its lower-left corner.

A shortcut lets you open a file or folder from a more convenient location. For
example, directly from your desktop or from the Start menu, or automatically at
Startup. You can open any object—including folders, disk drives, other
computers, or printers—using a shortcut.

A shortcut does not change a file’s location. It can point to a file or resource on
your computer or on a network server. A shortcut can even represent a paragraph
in a document. You can have multiple shortcuts to the same object and you can
copy and delete shortcuts. Note that when you delete a shortcut it does not affect
the original object.

Opening a Document Directly from Your Desktop

You can open a file or folder directly from your desktop. For example, if you
write a letter to David every day, you can place a shortcut icon to that file on the
Windows NT desktop. You can then open the document directly from your
desktop by double-clicking the “Letter to David” icon.

To open a document directly from your desktop
1. In My Computer, locate the item you want to copy onto your desktop.
% , 2. Use the right mouse button to drag the item to the desktop. You can see that

you are moving the icon because there is an arrow pointing to it as it moves.
Release the mouse button when the item is directly on the desktop.
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3. A menu appears when you release the mouse button. Left-click Create
Shortcut(s) Here.

1 Letter & gavid Lettet to Maxi  Letterto Dr.  Letter to Clara
k Smith

4. The shortcut icon appears on your desktop. You can now open the Letter To
David file directly from your desktop.

o I cawinNT I5vpofiles\usen o
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; Sith
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Recycle Bin

Opening a Program Automatically

It is convenient to have the programs that you use most often open automatically
when you start Windows NT. To do this, create a shortcut to the program in your
Startup folder.

To open a program automatically when you start Windows NT
1. From the Start menu the Find command, and click Files or Folders.

2. Type the name of the file, program, or folder you want to create a shortcut to,
and then right-click it.
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3. Click Create Shortcut.

CAWINDOWSHYHELP 2KB  CNT File
L DIMDVS\HELP 28KB  Help File

4. A message appears asking if you would like to create a shortcut on the
desktop. Click Yes.

The shortcut appears on your desktop.
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5. Using the Find command, locate the Startup folder on your computer.

Startup T CAMSOFFICESWIN " File Folder
EAWINDOW'S 3KB  Microsoft Program Gr...
] StartUp CAWINDOWS\Start... File Folder

£ LIMM TR eemf Colder

Charbiim

Schedule+
Reminders
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7. Drag the shortcut from the desktop into the Startup window and release the
mouse. Your program will now begin automatically at Startup.

sy Dompitet
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Opening a Document Directly from the Start Menu

You can create a shortcut that will enable you to open a document directly from
the Start menu. Your shortcut icon will appear at the top of the menu.

To open a document directly from the Start menu

¢ In My Computer or Explorer, right-click the document you want, and drag it
onto the Start button. The icon will appear at the top of the Start menu, and
you can open it by clicking it.

Changing the Way Windows NT Works and Looks

To change the way Windows NT works and looks, use the icons in Control
Panel. These icons represent options, including network and sound capabilities,
for configuring your computer. The icons in Control Panel will vary, depending
on the devices you installed on your computer.
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To view Control Panel

® (lick the Start button, point to Settings, and then click Control Panel.

The following table shows many of the icons likely to appear on your screen, and

explains their uses:

Choose

To

Accessibility
Options

Add/Remove

Programs

Console

Date/Time

Devices

Display

Fonts

Keyboard

Modems

Mouse

Multimedia

Network

PC Card
(PCMCIA)

Change your computer screen, mouse, keyboard features,
and sound to make Windows NT more accessible for
people with disabilities.

Install and remove software automatically, and add or
remove installed components in Windows NT.

Change the appearance of your MS-DOS screen by
changing screen colors, screen size and position, fonts,
cursor size, and more.

Change the system date, time, and time zone.

Start, stop, and configure the startup type for device drivers.

Change the appearance of your screen by changing screen
colors, fonts, the appearance and size of windows,
background design, icons, and other visuals.

Add or remove screen, vector, TrueType, and Type 1 fonts.
Some printer fonts are installed automatically when you
install a printer. Other printer fonts must be installed using
a font installation program provided by the font
manufacturer.

Adjust the keyboard delay and repeat rate, and add
keyboard symbols that are exclusive to other languages.

Add modems using the Add Modem wizard, a step-by-step
modem setup program.

Customize elements such as speed and button functions for
your pointing device.

Adjust audio, video, CD (music), and MIDI, and add or
remove multimedia devices.

Configure network adapter cards, network services and
protocols, and join a workgroup or a domain.

Display resources used by any PC cards, if you have these
devices.

(continued)
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Choose To
Ports Set parameters for, and add and remove serial
‘ communications ports.
Printers Add and remove printers using the Add Printer wizard, a
step-by-step printer setup program.
Regional Change sort dates, time, currency, and numbers to reflect
Settings regional standards.
SCSI Adapters ~ Display adapters and devices connected to your computer.
Server Display user and share information.
Services Start, stop, pause, or continue the services available on the
computer, and configure startup options.
Sounds Assign sounds to system and application events, and turn on
or off the warning beep and system sounds.
System Specify the default operating system for startup, change

Tape Devices

Telephony

UPS

user environment variables, and define paging file size.
Display, add, and remove tape devices.

Display, add, and remove telephony drivers. Change
telephony properties. Adjust telephony conditions

depending on whether your computer is docked or
undocked.

Create settings for Uninterrupted Power Supply.




